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Startup

To start the Agilent 7700 Series ICP- MS MassHunter Workstation software:

• Double- click the ICP MS Top desktop icon , or 

• Select Programs > ICP- MS MassHunter Workstation > ICP- MS Top from 
the Windows Start menu.

The ICP- MS Top window opens:

Toolbar The following shortcuts are available on the ICP- MS MassHunter Workstation 
toolbar:

Button Action Button Action

Display Instrument Status Panel Display Data Acquisition Panel

Display Tuning Panel Display Data Analysis Panel

Run Current Method Run Current Sequence

Run Method Wizard Edit Sequence

Edit Method Load Sequence

Load Method Save Sequence

Save Method Display online help window
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Preparing for Analysis

The following topics will help you prepare the instrument for analysis with 
Agilent 7700 Series ICP- MS MassHunter Workstation.

Things to check before analysis

Utilities

• Argon gas pressure: 500 to 700 kPa
• Cell gas (Helium): 90 to 130 kPa
• Cell gas (Hydrogen): 20 to 60 kPa
• Exhaust duct (on)
• Cooling water (Chiller or heat exchanger on)
• Drain and rinse tank (not full)

Peristaltic pump tubing

• Sample, drain, and internal standard lines

Prepare tuning solutions

You will need the following standards and solutions for ICP- MS operation:

• Tuning solution (1ppb Li, Co, Y, Ce, Tl)

• Internal standard solution

• Dilute the P/A factor tune solutions 75x, then mix the two solutions 1:1 to 
prepare a P/A factor tune solution for use in the lab. PA factor tuning is 
used to achieve linear functionality across the detector’s pulse and analog 
modes. Pulse mode is used to quantitate relatively low concentrations (ppb 
range). Analog mode is used to quantitate relatively high concentrations 
(ppm range).
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Ignite the plasma

1 Open the Instrument Control panel in either of the following ways:

• Select Instrument Control from the Instrument menu, or 

• Click the Instrument Control  icon.
The ICP- MS Instrument Control panel opens:

2 Confirm that the instrument is in Standby mode by checking the title bar of 
the Instrument Control panel.

3 Ignite the plasma by clicking the Ignite Plasma  icon in the toolbar.
4 Once the plasma is on and the instrument goes from standby to analysis 

mode, check tuning as described in the following section.
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Check tuning

The following diagram labels the parts of the ICP- MS instrument. You can 
refer to this diagram during the discussion of tuning parameters in this 
section.

Open the Tuning panel by selecting Tune from the Instrument menu,  
or by clicking the Tune  icon on the ICP- Top toolbar.

Ion Source
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Toolbar The following items (shortcuts) are available on the Tuning panel toolbar:

Tip See the “Tuning 7700” in online help for more information on individual 
tuning parameters.

Plasma Correction

Execution of plasma correction is necessary in the following cases:

• When the instrument is installed

• When the nebulizer has been changed 
(However, if the same nebulizer unit is reused repeatedly by detaching and 
reattaching, it is not necessary to conduct the correction each time as long 
as the nebulizer is installed correctly.)

• When the sampling cone is changed

• When the torch is changed

• When the matrix tolerance has changed after the instrument has been used 
for 6- 12 months and normal maintenance procedures have been followed

Once plasma correction is performed, there is no need to conduct it again in 
most cases, provided the instrument is used for normal measurement.

Button Action Button Action

Load tuning parameters from file Save tuning parameters to file

Generating tuning report Print current graph

Tune sensitivity Tune Oxide Ion

Tune Doubly Charged Ion Resolution and Axis

Select Mode & start Autotune Set Acquisition parameters for tuning

View meter control panel Display online help window
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Operating Method

When performing plasma adjustment, use a 1pbb tuning solution containing 
Ce. The following explains the method, refer to the online help.

Settings for Preset Mode

Select the nebulizer and tuning type, and set to the Preset mode. Under the 
Preset mode, parameters such as RF power, sampling position, carrier gas flow 
rate, makeup gas flow rate, and nebulizer pump speed are fixed to the preset 
values. 
1 In the Tuning window, select Preset Plasma >> Select Plasma.

The Plasma Select dialog appears.
2 Check the Preset Mode box.
3 Select the type of nebulizer to be used from the drop- down menu (For 

7700x).
4 Select Robust or one of the 3 levels of Ultra Robust (For 7700x). Select Hot 

Plasma (For 7700s).
If the matrix concentration exceeds 1%, select Ultra Robust- Level: High (if 
the desired sensitivity is not achieved, select Level Medium or Low). 

5 Click OK.
The Tuning window becomes active.

Checking the Tuning

Check the tuning as follows:
1 Check the each parameters:

• Open the last- used tuning file (typically nogas.u, h2.u or he.u).

• Select Acquisition Parameters from the Acq. Params menu. Set the mass 
numbers to be measured as 7 (Li), 89 (Y), 205 (Tl), and 156/140 (Ce oxide 
formation rate) and click OK.

• Check the following values displayed on the Tuning window:
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2 If the desired sensitivity is not achieved, select Autotune from Tume menu. 
Refer to the Help and execute Autotune.

3 After completing autotune, check the sensitivity parameters on the ICP- MS 
Tuning -  Sensitivity window. 

4 Save the tune file by selecting Save from the File menu. In general you will 
want to overwrite the tune file that was open, so that it has the updated 
values.

5 (optional) Generate a tune report by selecting Generate Report from the 
File menu. Enter optional comments if desired and click OK. A report 
showing the following information is sent to your printer:

• Sensitivity data
• Resolution/Axis data
• Lens parameter settings
Depending on how your system is configured, tuning results will also be 
recorded in the maintenance log.

Tip You can also get a hard copy of current tune parameters by clicking the 
Stop button and selecting Print from the File menu.

Table 1 Typical Sensitivity Values (For 7700x)

Mass Sensitivity (cps/ppb)

No Gas Mode He Gas Mode
(3.6ml/min)

H2 Gas Mode
(4.0ml/min)

7Li 30,000 --- ---
59Co --- 24,000 ---
89Y 100,000 --- 60,000
205Tl 60,000 --- ---

Oxide ratio ≤ 1.5% (≤2% for MicroFlow Nebulizer)
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Reference: For 7700x 

The recommended tuning parameter values for 7700x are shown below.

*1 Generally, set the QP Bias at least 2 to 3V higher than OctP Bias.

*2 High-Energy Collision mode allows for enhanced reduction of interference under the Helium mode. 
However, as it will also result in reduced low-mass sensitivity, it should be used in accordance with 
the purpose of the analysis.

Table 2 Recommended Values for 7700x (When Using a MicroMist Nebulizer) 

Parameter No Gas Mode Cell Gas Mode High Energy Collision Mode *2

Recommended 
Value

Recommended 
Range

Recommended 
Value

Recommended 
Range

Recommended 
Value

Recommended 
Range

RF Power [W] 1550 Fixed 1550 Fixed 1550 Fixed

Smpl Depth [mm] 8.0 Fixed 8.0 Fixed 8.0 Fixed

Carrier Gas [L/min] 1.05 1.01 to 1.11 1.05 1.01 to 1.11 1.05 1.01 to 1.11

Makeup Gas [L/min] 0 0 to 1.11 0 0 to 1.11 0 0 to 1.11

Dilution Gas [L/min] 0 Fixed 0 Fixed 0 Fixed

Neb Pump [rps] 0.1 Fixed 0.1 Fixed 0.1 Fixed

S/C Temp [degC] 2 Fixed 2 Fixed 2 Fixed

He or H2 gas [ml/min] 0 Fixed 3.6 (He)

4.0 (H2)

3.2 to 4.0 (He)

3.6 to 4.4 (H2)

10 (He) 7 to 10 (He)

Extract 1 [V] 0 Fixed 0 Fixed 0 Fixed

Extract 2 [V] -180 -200 to -160 -180 -200 to -160 -180 -200 to -160

Omega Bias [V] -80 -110 to -70 -80 -110 to -70 -80 -110 to -70

Omega Lens [V] 10 7 to 12 10 7 to 12 10 7 to 12

Cell Entrance [V] -30 -40 to -30 -40 -40 to -30 -130 -150 to -110

Cell Exit [V] -50 -60 to -40 -60 -60 to -40 -150 Fixed

Deflect [V] 10 8 to 15 0 -5 to 4 -80 -90 to-70

Plate Bias [V] -40 -50 to -30 -60 Fixed -150 Fixed

OctP RF [V] 180 150 to 200 180 150 to 200 190 180 to 200

OctP Bias [V] *1 -8 -10 to -6 -18 Fixed -100 Fixed

QP Bias [V] *1 -3 -7 to -3 -15 Fixed -96 -97 to -90
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Reference: For 7700s 

The recommended tuning parameter values for 7700s are shown below.

*1 Generally, set the QP Bias at least 2 to 3V higher than OctP Bias.

*2 High-Energy Collision mode allows for enhanced reduction of interference under the Helium mode. 
However, as it will also result in reduced low-mass sensitivity, it should be used in accordance with 
the purpose of the analysis.

Table 3 Recommended Values for 7700s (When Using a MicroFlow Nebulizer) 

Parameter High Sensitivity Cell Gas Mode High Energy Collision 
Mode*2

Cool Plasma

Recom-
mended 

Value

Recom-
mended 

Range

Recom-
mended 

Value

Recom-
mended 

Range

Recom-
mended 

Value

Recom-
mended 

Range

Recom-
mended 

Value

Recom-
mended 

Range

RF Power [W] 1500 fixed 1500 fixed 1500 fixed 600 fixed

Smpl Depth [mm] 8 7 to 10  8 7 to 10  8 7 to 10  18 fixed

Carrier Gas [L/min] 0.7 fixed 0.7 fixed 0.7 fixed 0.7 fixed

Makeup Gas [L/min] 0.5 0.3 to 0.7  0.5 0.3 to 0.7  0.5 0.3 to 0.7  0.75 0.6 to 1.2  

Dilution Gas [L/min] 0 fixed 0 fixed 0 fixed 0 fixed

Neb Pump [rps] 0.1 fixed 0.1 fixed 0.1 fixed 0.1 fixed

S/C Temp [degC] 2 fixed 2 fixed 2 fixed 2 fixed

He or H2 gas [ml/min] 0 fixed 3.6(He)

4.0(H2)

3.2 to 4.0(He)  

3.6 to 4.4(H2)  

10(He) 7 to 10(He)  0 fixed

Extract 1 [V] 4.5 3 to 7  4.5 3 to 7  4.5 3 to 7  -120 -200 to -40  

Extract 2 [V] -100 -170 to -60 -100 -170 to -60 -100 -170 to -60 -5 -30 to 5

Omega Bias [V] -70 -100 to -30 -70 -100 to -30 -70 -100 to -30 -70 -120 to -30

Omega Lens [V] 11 5 to 15 11 5 to 15 11 5 to 15 6 3 to 10

Cell Entrance [V] -30 -40 to -30 -40 -40 to -30 -130 -150 to -110 -30 -40 to -30

Cell Exit [V] -50 -60 to -40 -60 -60 to -40 -150 fixed -60 fixed

Deflect [V] 12 8 to 15 0 -5 to 4 -80 -90 to -70 9 5 to 13

Plate Bias [V] -40 -50 to -30 -60 fixed -150 fixed -60 fixed

OctP RF [V] 180 150 to 200 180 150 to 200 -190 180 to 200 150 100 to 200

OctP Bias [V] *1 -8 -12 to -6 -18 fixed -100 fixed -18 -30 to -10

QP Bias [V] *1 -3 -5 to -3 -15 fixed -96 -97 to -90 -5 -5 to -3
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Setting Quantitative Method Parameters

The following topics will help you create an acquisition method for 
quantitative analysis with the Agilent 7700 Series ICP- MS MassHunter 
Workstation.

Set up a Quantitative Method

Create a quantitative method for environmental analysis as described below:
1 Select Edit Entire Method from the Methods menu. This initiates a series 

of dialog boxes, so you can set the parameters for your method. See the 
online help for a full description of the items on these dialog boxes.

Tip See also “Use the Method Wizard to create a method” on page 19.
2 On the Edit Method dialog box, mark the following options, then click OK.

3 On the Method Information dialog box:

a Enter a comment 

b Mark the Data Analysis check box to run the data analysis automatically 
after data acquisition. For instructions on setting up a Data Analysis 
method, see “Open an existing batch for data analysis” on page 26.

c Click OK. 
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4 On the Select Sample Types (or Select QC Items, if the Intelligent Sequence 
software is installed) dialog box:

a Configure the list of Selected QC Items on the right to contain CalStd 
and Sample only. 

b Depending on the method you started with, you may have to use the 
Add- > and <- Remove buttons to create the desired list.

c Click OK.
5 On the Interference Equations dialog box:

a Display interference correction equations in one of the following ways:

• Mark Show All Masses to display all interference correction equations.

• From the pull- down menu at the bottom right, select Interference 
Equation Library, to display interference correction equations in the 
selected library.

b To edit the interference equation for a mass:

• Click on the desired mass number in the list.

• Click the Edit button to open the Edit Equation dialog box.

• Edit the equation as described in online help and click OK to close the 
Edit Equation dialog box.

c Repeat Step 5b for all masses you want to edit. 

d (optional) Click the Save button on the Interference Equation dialog box 
to save the edited equations for use with other methods.

e When finished, click OK.
6 On the Acquisition Mode dialog box:

a Check the Spectrum (Multi Tune) option.

b Click OK. Multi Tune allows you to use different tuning modes (e.g. 
Hydrogen and Helium modes) for different elements in a single run.
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7 Specify the masses and element to analyze as follows:

a On the Spectrum (Multi Tune) Acquisition Parameters dialog box, click 
the Periodic Table button as shown below:

This opens the Masses dialog box shown below:

7a
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b Using Table 4 on page 18 as a guide, click to select the masses to 
monitor for each element. Selected masses appear in red in the 
dialog box. 
Double- click on a element to open the Select Isotopes dialog box. 
Click the buttons for the isotopes you want to monitor. You can 
select one or more isotopes per element. Red check marks indicate 
the selected isotopes. To clear an isotope, click the right mouse 
button. Click OK when you are finished selecting isotopes for that 
mass.

c Repeat Step 7b to set up each mass as shown in Table 4. 

d When you are finished, click the Mass Table button. The Mass Table 
dialog box opens to display the masses to be monitored for each element. 
Check that the masses listed in the Mass Table dialog box match those 
shown in Table 4 and adjust them if necessary. This is the list of 
masses that will be monitored in the method.

e When finished setting up all the required elements and masses, click OK 
on the Mass Table and Masses dialog boxes.

8 Set the Tune File and Stabilization time for each step in the upper right 
area of the Spectrum (Multi Tune) Acquisition Parameters dialog box:

Step Tune File Stabilization Time

1 Hydrogen mode 30 sec

2 Helium mode 30-50 sec
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9 Set the Integration time per Point for each mass: 

a Click on the row for the mass in the column for the appropriate step (i.e. 
Step 1 for Hydrogen mode, Step 2 for Helium mode) as specified in the 
Reaction Gas column in the Table 4 on page 18. You can select 
multiple masses by <Ctrl>+clicking on them.

b Enter the Integration time per Point as specified in Table 4. The 
integration times in the table are generally relatively short, and can 
be extended as necessary.

c Click the Enter button. The per Point integration time and calculated 
per Mass integration time will be updated in the table.

d Repeat for each mass in the table. For masses such as 71 that are 
monitored in both steps, remember to enter integration times for both.

9a

9b

9c
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10 Make the following additional selections on the Spectrum (Multi Tune) 
Acquisition Parameters dialog box:

a Select Full Quant (3) for the Peak Pattern. 

b Set the Repetition count to 3. 

c Mark the Return to First Tune Step option at the bottom of the screen, 
and click OK.

11 On the Peristaltic Pump Program dialog box, set the following parameters, 
then click OK. See online help for more information on these parameters 
and on the optional features: Intelligent Rinse and Execute Pre- emptive 
Rinse.

• Before Acquisition

• After Acquisition (Rinse Port)

• After Acquisition (Rinse Vial)
12 (optional) Set up pre- emptive rinsing as follows: 

a Select Set PeriPump Program from the PeriPump menu in the 
Acquisition window. 

b On the Peristaltic Pump Program dialog box, mark the Execute 
Pre- emptive Rinse option at the bottom of the screen. 

c Enter an initial time of 15 seconds, then click OK. 

d Adjust the time so that the analysis is completed 5 seconds before the 
rinse solution reaches the nebulizer. 

13 To save the method:

a On the Method Save Options dialog box, mark all items, and click OK. 

b On the Save Method As dialog box, enter a method name, and click OK.

10b

10a

10c
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1) Can be subject to interferences.
2) ISTD solution P/N is 5188-6525. See page 23 for more information.
3) Alternate internal standards are shown in parentheses.
4) When H2 option is installed (then better MDL can be achieved).

Table 4 Set up information for elements and masses for Environmental Analysis

Element Mass Confirmation 
Mass1

Mode Internal 
Standard2

Approx. Integration 
Time (sec/Point)

Be 9 No gas 6Li 0.3

B 11 No gas 6Li 0.1

Na 23 He 45Sc 0.05

Mg 24 He 45Sc 0.05

Al 27 He 45Sc 0.3

P 31 No Gas 6Li (72Ge, 45Sc)3 0.1

K 39 He 9 or 71 0.05

Ca 44 43 He 9 or 71 0.1

V 51 He 45Sc 0.5

Cr 52 53 He 45Sc 1

Mn 55 He 45Sc 0.1

Fe 56 57 He 45Sc 0.1

Co 59 He 45Sc 0.1

Ni 60 He 45Sc 1

Cu 63 65 He 45Sc 0.1

Zn 66 64 He 72Ge 0.1

As 75 He 72Ge 1

Se 78 He or (H2)4 72Ge 5

Br 79 No Gas 72Ge 0.1

Mo 95 98 He 103Rh 0.1

Ag 107 109 No Gas 115In 0.1

Cd 111 114 No Gas 115In, (209Bi) 1

Sn 118 No Gas 103Rh (115In, 209Bi) 0.1

Sb 121 No Gas 115In, (209Bi) 0.1

I 127 No Gas 103Rh (115In, 209Bi) 0.1

Ba 137 135 No Gas 115In, (209Bi) 0.1

Hg 201 202 No Gas 209Bi 1

Tl 205 No Gas 175Lu, (209Bi) 0.1

Pb 208 No Gas 175Lu, (209Bi) 0.1

Th 232 No Gas 175Lu, (209Bi) 0.1

U 238 No Gas 175Lu, (209Bi) 1
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Access Method parameters directly

You can access some method panels directly, using the following menu items:

Use the Method Wizard to create a method

This way of creating a method makes it easy to create methods for 
environmental analyses, since it supplies many of the parameters that are 
appropriate for various sample types and regulations.
1 Select Run Method Wizard from the Methods menu in ICP- MS Top.

General Items 2 Enter name for the method and click the Next> button.

Sample 3 Select the sample as follows:

a Select Environmental as the Application Type.

b Select a Sample, such as Drinking Water or High TDS. A description of 
the current selection is displayed in the lower part of the window.

c Select a Regulation, such as EPA200.8 or EPA6020. Only the guidelines 
that apply to the selected sample are displayed.

d Click the Next> button.

Method parameters Window Menu Menu item

Method Information ICP-MS Top Methods Edit Method Information

Select Sample Items, 
Select QC Items 
(Intelligent Sequence 
Software is installed)

ICP-MS Top Methods Select QC Items

Interference Equation ICP-MS Top Methods Edit Interference Equation

Acquisition Mode Acquisition EditParameters Set Mode

Spectrum Acquisition 
Parameters

Acquisition EditParameters Set Parameters

Peristaltic Pump 
Program

Acquisition PeriPump Set Peripump Program

Method Save Options ICP-MS Top Methods Save As
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Elements 4 The list of masses and elements that will be monitored is displayed. The 
information in this list is based on the sample and regulation selected 
above. Review the element information and make any changes as follows:

a Right- click on the element of interest in the Element List Information.

b Select one of the following options from the shortcut menu:

• Add -  see Step 4c below
• Delete -  removes the selected mass from the list
• Edit -  see Step 4c below

c If you are adding or editing an element, enter the following information 
on the Add (or Edit) Elements dialog box, then click OK.

• Mass
• Element Name
• Integration time (sec/Point)
• Tune step number

d (optional) Click the Edit/View Equation button to view or edit an 
interference correction equation. See online help for more information.

e Click the Next> button.

Finish 5 Review the method information, then click the Finish button. 

Tip You can edit the method later by selecting Edit Entire Method from the 
Methods menu and marking the parts of the method to edit, or from the menus 
items shown in the previous section.
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Running the Samples

The following topics will help you prepare a sequence, and run your samples 
with the Agilent 7700 Series ICP- MS MassHunter Workstation.

Set up the Sequence

Set up a sequence for your analysis as follows:
1 Select Edit Sample Log Table from the Sequence menu in the ICP- MS Top 

window. The samples you enter will be injected in the order they are listed 
in the table.

2 Enter the following information for the first sample (Row 1) of the table:

a Method: Double- click in the Method column of Row 1 to open the Select 
Method dialog box. Select the desired method and click OK.

b Type: Click in the Type column of Row 1 to open a list of types.

• Select CalBlk for calibration blanks.

• Select CalStd for calibration standards.

• Select Sample for unknown samples.

c Vial: Click in the Vial column of Row 1 and enter the vial number of the 
first sample or standard.

• The large bottles for cleaning solutions are positioned at 1, 2, and 3.

• The small vials on the rack are positioned at 1001, 1002, 1003... etc.

d Data File: Leave this cell blank to assign a file name automatically at run 
time.

e Sample: Enter a name for the sample in the Sample column.

f Comment: Enter a comment for the sample in the Comment column.

g Dil/Lvl: Specify a Dilution factor or Level.

• For standard solutions: click in the Dil/Lvl column of Row 1 and select 
the desired level from the list.

• For samples: click in the Dil/Lvl column of Row 1 and type in the 
dilution factor (1 for undiluted), or double- click to open the Calculate 
Dilution Factor dialog box. See online help for more information.

h ISTD Conc: Double- click in the ISTD Conc column of Row 1 to open the 
Set ISTD Conc dialog box. Select the desired calibration level or set a 
ISTD Conc value, then click OK.
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3 Fill in values for the rest of your samples as follows:

a Select the first row and the subsequent rows by dragging the mouse.

b Right- click in the highlighted rows and select Fill Down from the 
shortcut menu.

c The values for Method, Type, Dil/LVL and ISTD Conc are copied from 
Row 1 to the selected blank rows. Sequential Vial numbers are assigned.

4 Modify the information for the sample rows added in Step 3 to match your 
analyses.

5 (optional) To turn off the plasma automatically at the end of the sequence, 
append the following row to the end of the sequence:

• Type: Keyword 

• Data File: StandBy 

• Leave all other cells blank
6 (optional) Select the Import DA Method from Existing Batch check box to 

import an existing data analysis method from the specified data batch 
directory. You can import the DA Method Only or the DA method and Std 
Data. You can also apply a data analysis method after data acquisition.

7 Click OK to close the Edit Sample Log Table dialog box. 
8 If errors are found in the table, a message appears. 

a Click OK and the offending cell will be highlighted in the table.

b Fix the problem in the highlighted cell.
9 Repeat Steps 7 & 8 until no errors are detected.
10 (optional) Select Save from the Sequence menu in the ICP- MS Top window. 

Enter a name for the sequence you just created, and click OK. You don’t 
need to save a sequence to run it, but doing so allows you to open it later 
and use it as a starting point for creating a new sequence more quickly.
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Analyze the samples

1 Prepare the following standards, samples, and each solutions to use for 
analysis. The solutions should contain 0.5% HCl as well as nitric acid.

• Make up the following calibration standards by diluting SPEX 
XSTC- 760A with nitric acid to approx. 1%. The concentration of the 
undiluted solution is 100x that of drinking water quality standard.

• Dilute samples with nitric acid to approx. 1%

• Dilute Internal standard solution (P/N 5188- 6525) 200 times (for on- line 
internal standard)

• Use of nitric acid (1 to 5%) is recommended for the cleaning solution, as 
it will clean the introduction system better than pure water. If pure 
water is used, residual memory may be washed out while introducing 
acidic samples, affecting the quantitative measurement. 

2 Select Run from the Sequence menu or click the  icon on the toolbar to 
open the Start Sequence dialog box.

3 Set the parameters to the desired values.

Calibration 
curve ranges

SPEX XSTC-760A Na 
(ppm)

Mg, K, Ca
(ppm)

Level 1 Blank HNO3 0 0

Level 2 1/1000 dilution (1/10 of standard) 10 5

Level 3 1/200 dilution (1/2 of standard) 50 25

Level 4 1/100 dilution (standard concentration) 100 50

For high-concentration Na, Mg, K, and Ca, it is safer to prepare their mixed standard 
solutions separately instead of mixing with the SPEX mixed standard solution, so as to 
prevent contamination with the reagent, particularly if the required concentration level is 
1/100 of the standard.
G7200-90210 (Rev. A) MassHunter Workstation Quick Start Guide 23



4 The Data Batch Directory is set to a unique name based on the current 
date and time. The format is year, month, day, hour, and sequential 
numbers. For example, 08H14K01.B is the second batch directory created 
between 10AM and 11AM on August 14, 2008. The parts of the name are 
derived as follows:

If you wish, you can type in a different directory name instead. The name 
can be up to eight characters long. The batch folder will be created in 
C:\ICPMH\1\DATA\.

5 (optional) Select the Import DA Method from Existing Batch check box to 
import an existing data analysis method from the specified data batch 
directory. You can import the DA Method Only or the DA method and Std. 
Data.

6 Click the Edit DA Method button in the lower left of the dialog box, then 
create a Data Analysis method as described on page 28.

7 Click the Run Sequence button to start the run. The Run Sequence Status 
dialog box appears.

8 If desired, you can monitor acquisition as described in online help.
9 When the sequence is complete, analyze the data as described in the 

following section.

08 = 2008
H = August  

(month - A through L corresponds to the 12 months, in order, so A = January, etc.) 
14= the day of the month
K= the hour of the day 

(A - X correspond to 0 - 23)
01= a sequential number for sequences run within the same hour, i.e. 00, 01, 02, and so on
.B= the file extension for a batch file
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Quantitative Data Analysis

The following topics will help you perform data analysis on your samples with 
the Agilent 7700 Series ICP- MS MassHunter Workstation.

Typical scenarios for Data Analysis

Description

To import an existing 
method

The data was acquired with reference to a Data Analysis (DA) method. 
(E.g. the “Edit DA Method” button was clicked or the “Import DA Method from Existing Batch” 
option was selected when setting up the sequence).  
In this scenario, the ICP-MS Data Analysis window opens automatically after acquiring the data. 
Proceed in one of the following ways:
• If no changes are required to the DA method, then proceed to “View analysis results” on 

page 33 and to “Generate a report” on page 34.
• If you wish to modify the existing DA method for this acquired data, then proceed to “Create 

the Data Analysis (DA) method for Quantitative data analysis” on page 28 to open the Method 
Editor and make changes to the DA method.

To create a method 
after completing data 

acquisition

The data was acquired without reference to a DA method. 
In this scenario, the ICP-MS Data Analysis window opens automatically after acquiring the data, 
but only the file name is displayed, since no analysis method has yet been applied. Proceed as 
follows:
a Open the method editor as described in “Create the Data Analysis (DA) method for Quantitative 

data analysis” on page 28.
b Proceed to create a DA method for Quantitative data analysis.

To create a method 
before performing data 

acquisition

You want to create a DA method without reference to any acquired data.
a Follow the steps in“Open an existing batch for data analysis” on page 26 to create a new batch 

folder, since a data batch does not already exist.
b If desired, import samples as described in Step 3.
c Proceed to “Create the Data Analysis (DA) method for Quantitative data analysis” on page 28.
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Open an existing batch for data analysis

If the window is not already open, open the ICP- MS Data Analysis window in 
either of the following ways:

• Select Main Panel from the DataAnalysis menu in the ICP- MS Top window, 
or 

• Click the  button on the ICP- MS Top toolbar.

Tip To open an existing batch:

a Select Open Analysis File from the File menu to open the Open Batch 
dialog box.

b Select the file of interest and click Open. This opens an Analysis file with 
data that has been previously acquired.

c Then proceed to “Create the Data Analysis (DA) method for 
Quantitative data analysis” on page 28 to create a Data Analysis 
(DA) method (if a DA method was not applied at time of data 
acquisition) or to modify the method, if needed (if the DA method 
was already applied).

Creating a new batch for data acquisition

1 Create a new Batch Folder, which will be used to contain your data analysis 
results:

a Open the New Batch Folder dialog box in either of the following ways:

• Click the New Batch Folder toolbar button , or 

• Select New Batch Folder from the File menu.

b Type in a name for the new folder (you may select a different location if 
desired).

c Click the Create button.
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2 Import the samples as follows:

a Select Import Samples from the File menu.

b Navigate to the data file folder where the data files of interest are located 
and click the Open button. The data files in that folder are displayed on 
the Import Samples dialog box.

c To import samples from another folder, click the Browse button.

d Repeat Steps b and c until all samples of interest are displayed on the 
Import Samples dialog box.

e Select the samples to import:

• <Ctrl>+click to select multiple samples from the list.

• Click the Select All button to select all samples in the list.

f Click OK.
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Create the Data Analysis (DA) method for Quantitative data analysis

1 Open the Method Editor window in either of the following ways:

• Click the Edit Method toolbar button , or 

• Select Edit from the Method menu.

Tip To import existing DA method, click Import Method only or Import 
Method and Standard Data and select an analysis file to import.

2 Select Data Analysis Method from Method Tasks section 2 (on the left side 
of the screen) to display the Data Analysis Method pane

3 Set the options as follows:

a Mark the check box for FullQuant Analysis.

b Set the Analysis Mode to Spectrum.

c Select the correction method from the Interference Correction list.

4 Select a Sample Template from the list.

3a

3b

3c
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5 Select Analyte List from Method Tasks section 3 to display the Analyte List 
pane.

.

To open the analyte list from the existing data:

• Click the button, or

• Right- click in the pane and select Load list from acquired data.

Tip You can also create an analyte list in either of the following ways:

• To load an analyte list from an acquisition method that has already been 
developed, click the button.

• To add new analyte lines, click the button, then designate the Tune 
Step, Mass, Name and Analyte/ISTD for each new line as described in 
Step 6.

6 Enter the following information for each analyte:

a Click the  button at the right end of the Tune Step column, and select 
a tune step number.

b Click the  button at the right end of the Analyte/ISTD column and 
select either analyte or ISTD.
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7 Select Full Quant from Method Tasks section 4 to display the FullQuant 
Method Table pane:

8 Set the following calibration curve parameters:

• The calibration curve method (External Calibration / Standard Addition)

• Type of VIS correction for ISTD elements

• Curve fit type (Linear / Quadratic / Excluded)

• Handling of the origin (Ignore / Force / Blank offset)

• Calibration curve weight

• ISTD elements used for correction

• Concentration of the calibration curve level (Min Conc). For most 
applications, enter 0.

• Concentration unit

• Concentration of the blank
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9 The following Advanced Info method tasks are described in online help:

• FullQuant Outlier

• Edit Report Templates
10 Select Validate from Method Tasks section 5. Correct any method errors 

before proceeding.
11 Select Return to Batch- at- a- Glance from Method Tasks section 5.  

Click Yes to save the Data Analysis method.
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Process the batch

1 Initiate batch processing in either of the following ways:

• Click the Process Batch toolbar button , or 

• Select Process Batch from the Process menu.
Analysis is performed on the samples you added to the batch in the 
previous topic, using parameters set in the DA method. See “Create the 
Data Analysis (DA) method for Quantitative data analysis” on page 28..

2 Review the analysis results that are displayed in the Batch Table and 
Calibration Curve panes, as shown in the following examples. 

Note The Process Batch button changes to black after processing: .
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View analysis results

Batch Table 
pane

1 View the concentration and count for each element in the samples in the 
Batch Table pane.

• Concentration and count for problematic data (Outlier) are displayed 
with a color of each Outlier background. 

• See online help for information if you want to change the way the data is 
displayed, such as sorting or customizing the columns

• Also see online help for information on changing the layout or doing auto 
review.

Spectrum 
pane

2 View mass spectra in the Spectrum pane. You can zoom in to identify 
elements by right- clicking and dragging the mouse cursor around the 
desired mass number. See online help for information on other ways to 
display or process data in the Spectrum pane, such as:

• Switching between log and linear

• Switching between one- row and three- row

• Adding comments

• Identifying unknown spectra against an element database

• Subtracting background spectra

• Overlaying multiple spectra

• Tabulating the spectral information

Calibration Curve 
pane

3 View calibration curves for each element in the samples in the Calibration 
Curve pane.

• Problematic calibration curves (Outliers) are displayed with a pink 
background. 

• See online help for information on other changes you can make to the 
calibration curve, such as excluding a calibration curve level, changing 
the concentration of a calibration curve level, changing the calibration 
curve type, changing the handling of the origin, or changing the 
weighting of calibration curve.

ISTD Stability 
Graph pane

4 View the percent recovery of each ISTD element in the ISTD Stability Graph 
pane. See online help for more information.
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Save analysis results

Be sure to always save the analysis results in one of the following ways:

As a new file: Select Save Analysis File As from the File menu.

To overwrite an existing results file with the same name: 

• Click the Save toolbar button , or 

• Select Save from the File menu.

Generate a report

1 Select Generate from the Report menu in the MassHunter ICP- MS Analysis 
window.

2 Mark the desired report options and click OK (see example below).

3 Click OK to generate the report.
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Semi-Quantitative Analysis

Semi- quantitative analysis allows you to quickly scan and obtain information 
about the concentrations of all elements that are present in an unknown 
sample. It is useful when you want to obtain concentration information for a 
large number of elements (>70) without external calibration, such as screening 
prior to quantitative analysis on target elements. Typically, semi- quantitative 
analysis is accurate to +/-  30% or better on completely unknown samples.

Prepare for SemiQuant Analysis

Prepare the following samples and solutions for analysis:

• Samples (dilute with nitric acid to approx. 1%) 

• Tuning solution (Li, Co, Y, Ce, Tl, 1ppb each, with approx. 1% nitric acid) 

• Cleaning solution (1 to 5% nitric acid) 

Create a SemiQuant acquisition method

1 Select Edit Entire Method from the Methods menu. This initiates a series 
of dialog boxes, so you can set the parameters for your acquisition method. 
See the online help for a full description of the items on these dialog boxes.

2 On the Edit Method dialog box, mark the following options, then click OK.

3 On the Method Information dialog box, set the following parameters, then 
click OK:

a Enter a comment 

b Be sure that the Data Analysis check box is checked; this is required to 
run the data analysis automatically after data acquisition.
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4 On the Select Sample Types (or Select QC Items, if the Intelligent Sequence 
software is installed) dialog box, set the following parameters, then click 
OK:

a Configure the list of Selected QC Items on the right to contain Sample, 
SQStd, SQBlk, and SQISTD. 

b Depending on the method you started with, you may have to use the 
Add- > and <- Remove buttons to create the desired list.

5 Set the Data Acquisition method parameters:

a On the Acquisition Mode dialog box, mark the Spectrum option and click 
OK. 

b On the Spectrum Acquisition Parameters dialog box, click the Mass 
Scale button.

c On the Masses dialog box:

• Click the Clear All button.

• Select all mass numbers by double- clicking on the top, middle, and 
bottom rows, then click OK.

d Make the following additional selections on the Spectrum Acquisition 
Parameters dialog box, then click OK:

• Select Semi Quant (6) for the Peak Pattern.

• Clear the Set every Mass option, then set the per Point Integration 
time to 0.05 or 0.1 sec.

• Set the Repetition count to 1.

e On the Peristaltic Pump Program dialog box, set the following 
parameters, then click OK.

• Before Acquisition: Uptake Speed: 0 rps, Uptake Time: 0 sec, 
Stabilization Time: 70 sec

• After Acquisition (Rinse Port): Rinse time: 30 sec

• After Acquisition (Rinse Vial)
See online help for more information on these parameters and on the 
optional features: Intelligent Rinse and Execute Pre- emptive Rinse.

6 To save the method:

a On the Method Save Options dialog box, mark all items, and click OK. 

b On the Save Method As dialog box, enter a name for the method, and 
click OK.
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Analyze the samples

1 In the sequence table, set up a sequence with samples in the following 
order:

a Tuning solution (1 ppb Li, Co, Y, Ce, Tl) -  Sample Type is “SQStd”

b Blank (i.e. nitric acid) -  Sample Type is “SQBlk”

c Sample 1 - > Sample 2 - > Sample 3 ... -  Sample Type is “Sample”
2 Run the sequence:

a Select Run from the Sequence menu or click the  icon on the toolbar 
to open the Start Sequence dialog box.

b Click the Run Sequence button to start the run. The Run Sequence 
Status dialog box appears.

c If desired, you can monitor acquisition as described in online help.

Create a new batch or open a new batch for SQ data analysis

Refer to “Open an existing batch for data analysis” on page 26 and 
“Creating a new batch for data acquisition” on page 26.

NOTE
The same scenarios apply for offline Semi-quantitative data analysis as described in 
“Typical scenarios for Data Analysis” on page 25.
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Create the Data Analysis (DA) method for SemiQuant data analysis

1 Open the Method Editor window in either of the following ways:

• Click the Edit Method toolbar button , or 

• Select Edit from the Method menu.

Tip To import existing DA method, click Import Method only or Import 
Method and Standard Data and select an analysis file to import.

2 Select Data Analysis Method from Method Tasks section 2 (on the left side 
of the screen) to display the Data Analysis Method pane.

3 Set the options as shown below:

a Mark the check box for SemiQuant Analysis.

b Set the Analysis Mode to Spectrum.

c Select the correction method from the Interference Correction list.

4 Select a Sample Template from the list.

5 Select SemiQuant from Method Tasks section 3 to display the SemiQuant 
pane.

3a

3b

3c
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Tip You can select elements to show in the pane by clicking Add/Remove 
Standard Element.

6 On the SemiQuant Method Table pane:

a Mark the check box for Advanced Parameters.

b Set the concentration of the elements in the standard sample being used 
for the SemiQuant factor correction.

c Select the ISTD correction method.
For setting details, refer to “SemiQuant Pane” in the “Commands 
Reference” section of online help.

7 Select Validate from Method Tasks section 5. Correct any method errors 
before proceeding.

8 Select Return to Batch- at- a- Glance from Method Tasks section 5.  
Click Yes to save the Data Analysis method.

6a
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Process the batch

1 Initiate batch processing in either of the following ways:

• Click the Process Batch toolbar button , or 

• Select Process Batch from the Process menu.

Analysis is performed on the samples you added to the batch in the 
previous topic, using parameters set in the Data Analysis method, as 
described in “Create the Data Analysis (DA) method for SemiQuant data 
analysis” on page 38.
2 View/check the analysis results as follows:

a Batch Table pane- - Displays the concentration and count for each 
element in the samples.

b Spectrum pane- - Displays mass spectra. You can zoom in to identify 
elements by right- clicking and dragging the mouse cursor around the 
desired mass number.

c Semiquant Factor pane- - Displays the SemiQuant factor graph for each 
sample. Place the cursor near a point on a graph to display element 
names and SemiQuant factor correction details. Use the arrow keys to 
move between samples. If necessary, the factors can be changed as 
described in “Change the SemiQuant Factors” on page 42. 
If the SemiQuant Factor pane is not currently displayed, select 
Calibration Curve from the View menu. 

d ISTD Stability Graph pane- - Displays the percent recovery of each ISTD 
element in the samples. See online help for more information.

3 Save results using Save Analysis File As or Save from the File menu.
4 Select Generate from the Report menu, select report options, and click OK.
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Correcting the Semiquant Factors

On MassHunter Workstation, the SemiQuant factors are predefined for each 
element. The greater the SemiQuant factor, the more efficiently that element is 
ionized in the plasma, yielding a higher sensitivity. Use the following 
procedure to correct the SemiQuant factors, as necessary.
1 Select and measure standard sample containing three or four elements 

whose concentration are known. Make sure that the concentrations of the 
elements in the standard sample cover the low, medium, and high ranges of 
the mass spectrum, or use the tuning solution that contains Li, Co, Y, Ce 
and TI as the standard sample.

2 In the ICM-  MS Data Analysis window, load the data for the standard 
sample into the batch folder.

3 Set the sample type of the loaded Standard Sample to SQStd as shown in 
the example below:

4 Process the batch in either of the following ways:

• Click the Process Batch toolbar button , or 

• Select Process Batch from the Process menu.
The SemiQuant factor for all elements will be corrected based on the 
elements of known concentration in the standard sample (SQStd).
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Change the SemiQuant Factors

You can configure the SemiQuant factor, Base mass, and Reported mass 
(isotopes).
1 Select SemiQuant Basic Parameters from the Global drop- down menu in 

the ICP- Analysis window:

The SemiQuant Basic Parameters dialog box opens.

2 Make the change by either:

• Right- clicking within the table and selecting from the context menu; or 

• Selecting a cell and directly editing its content. 
Refer to the Help for more details.
42 G7200-90210 (Rev. A) MassHunter Workstation Quick Start Guide



Notices
© Agilent Technologies, Inc. 2009

No part of this manual may be reproduced in 
any form or by any means (including elec-
tronic storage and retrieval or translation 
into a foreign language) without prior agree-
ment and written consent from Agilent 
Technologies, Inc. as governed by United 
States and international copyright laws.

Manual Part Number
G7200-90210

Edition
Rev. A, June 2009

Printed in USA

Agilent Technologies, Inc. 
Hewlett-Packard-Strasse 8  
76337 Waldbronn, Germany

Warranty

The material contained in this docu-
ment is provided "as is," and is sub-
ject to being changed, without notice, 
in future editions. Further, to the max-
imum extent permitted by applicable 
law, Agilent disclaims all warranties, 
either express or implied, with regard 
to this manual and any information 
contained herein, including but not 
limited to the implied warranties of 
merchantability and fitness for a par-
ticular purpose. Agilent shall not be 
liable for errors or for incidental or 
consequential damages in connec-
tion with the furnishing, use, or per-
formance of this document or of any 
information contained herein. Should 
Agilent and the user have a separate 
written agreement with warranty 
terms covering the material in this 
document that conflict with these 
terms, the warranty terms in the sep-
arate agreement shall control.

Technology Licenses 
The hardware and/or software described in 
this document are furnished under a license 
and may be used or copied only in accor-
dance with the terms of such license.

Restricted Rights Legend
If software is for use in the performance of a 
U.S. Government prime contract or subcon-
tract, Software is delivered and licensed as 
"Commercial computer software" as 
defined in DFAR 252.227-7014 (June 1995), 
or as a "commercial item" as defined in FAR 
2.101(a) or as "Restricted computer soft-
ware" as defined in FAR 52.227-19 (June 
1987) or any equivalent agency regulation or 
contract clause. Use, duplication or disclo-
sure of Software is subject to Agilent Tech-
nologies' standard commercial license 
terms, and non-DOD Departments and 
Agencies of the U.S. Government will 
receive no greater than Restricted Rights as 
defined in FAR 52.227-19(c)(1-2) (June 
1987). U.S. Government users will receive 
no greater than Limited Rights as defined in 
FAR 52.227-14 (June 1987) or DFAR 
252.227-7015 (b)(2) (November 1995), as 
applicable in any technical data.

Safety Notices

WARNING

A WARNING notice denotes a 
hazard. It calls attention to an 
operating procedure, practice, or 
the like that, if not correctly per-
formed or adhered to, could result 
in personal injury or death. Do not 
proceed beyond a WARNING 
notice until the indicated condi-
tions are fully understood and 
met.

CAUTION

A CAUTION notice denotes a haz-
ard. It calls attention to an operat-
ing procedure, practice, or the like 
that, if not correctly performed or 
adhered to, could result in damage 
to the product or loss of important 
data. Do not proceed beyond a 
CAUTION notice until the indicated 
conditions are fully understood and 
met. 

NOTE

A NOTE contains helpful informa-
tion on the usage - it does not 
denote a hazard.

Agilent products must only be used in the 
manner described in the Agilent product 
user guides.  Any other use may result in 
damage to the product or personal injury.  
Agilent is not responsible for any damages 
caused, in whole or in part, by improper use 
of the products, unauthorized alterations, 
adjustments or modifications to the prod-
ucts, failure to comply with procedures in 
Agilent product user guides, or use of the 
products in violation of applicable laws, 
rules or regulations.



© Agilent Technologies, Inc. 2009

Printed in USA 
Rev. A, June 2009

*G7200-90210*
G7200-90210

www.agilent.com

Agilent Technologies

In this Book

This Quick Start Guide 
presents first steps to 
using the Agilent 7700 
Series ICP- MS MassHunter 
Workstation. 


	Agilent 7700 Series ICP-MS MassHunter Workstation
	Startup
	Preparing for Analysis
	Things to check before analysis
	Prepare tuning solutions
	Ignite the plasma
	Check tuning

	Setting Quantitative Method Parameters
	Set up a Quantitative Method
	Access Method parameters directly
	Use the Method Wizard to create a method

	Running the Samples
	Set up the Sequence
	Analyze the samples

	Quantitative Data Analysis
	Typical scenarios for Data Analysis
	Open an existing batch for data analysis
	Creating a new batch for data acquisition
	Create the Data Analysis (DA) method for Quantitative data analysis
	Process the batch
	View analysis results
	Save analysis results
	Generate a report

	Semi-Quantitative Analysis
	Prepare for SemiQuant Analysis
	Create a SemiQuant acquisition method
	Analyze the samples
	Create a new batch or open a new batch for SQ data analysis
	Create the Data Analysis (DA) method for SemiQuant data analysis
	Process the batch
	Correcting the Semiquant Factors
	Change the SemiQuant Factors




<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /None
  /Binding /Left
  /CalGrayProfile (Dot Gain 20%)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Warning
  /CompatibilityLevel 1.3
  /CompressObjects /Off
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJDFFile false
  /CreateJobTicket true
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /DetectCurves 0.0000
  /ColorConversionStrategy /LeaveColorUnchanged
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedOpenType false
  /ParseICCProfilesInComments true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveDICMYKValues true
  /PreserveEPSInfo true
  /PreserveFlatness true
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Remove
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /CropColorImages true
  /ColorImageMinResolution 300
  /ColorImageMinResolutionPolicy /OK
  /DownsampleColorImages false
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageMinDownsampleDepth 1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /CropGrayImages true
  /GrayImageMinResolution 300
  /GrayImageMinResolutionPolicy /OK
  /DownsampleGrayImages false
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageMinDownsampleDepth 2
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /CropMonoImages true
  /MonoImageMinResolution 1200
  /MonoImageMinResolutionPolicy /OK
  /DownsampleMonoImages false
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /CheckCompliance [
    /None
  ]
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile (None)
  /PDFXOutputConditionIdentifier ()
  /PDFXOutputCondition ()
  /PDFXRegistryName ()
  /PDFXTrapped /False

  /Description <<

    /BGR <>
    /CHS <FEFF4f7f75288fd94e9b8bbe5b9a521b5efa7684002000500044004600206587686353ef901a8fc7684c976262535370673a548c002000700072006f006f00660065007200208fdb884c9ad88d2891cf62535370300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c676562535f00521b5efa768400200050004400460020658768633002>
    /CHT <FEFF4f7f752890194e9b8a2d7f6e5efa7acb7684002000410064006f006200650020005000440046002065874ef653ef5728684c9762537088686a5f548c002000700072006f006f00660065007200204e0a73725f979ad854c18cea7684521753706548679c300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c4f86958b555f5df25efa7acb76840020005000440046002065874ef63002>
    /CZE <>
    /DAN <>
    /DEU <>
    /ESP <>
    /ETI <>
    /FRA <>
    /GRE <>

    /HRV <>
    /HUN <>
    /ITA <>
    /KOR <FEFFc7740020c124c815c7440020c0acc6a9d558c5ec0020b370c2a4d06cd0d10020d504b9b0d1300020bc0f0020ad50c815ae30c5d0c11c0020ace0d488c9c8b85c0020c778c1c4d560002000410064006f0062006500200050004400460020bb38c11cb97c0020c791c131d569b2c8b2e4002e0020c774b807ac8c0020c791c131b41c00200050004400460020bb38c11cb2940020004100630072006f0062006100740020bc0f002000410064006f00620065002000520065006100640065007200200035002e00300020c774c0c1c5d0c11c0020c5f40020c2180020c788c2b5b2c8b2e4002e>
    /LTH <>
    /LVI <>
    /NLD (Gebruik deze instellingen om Adobe PDF-documenten te maken voor kwaliteitsafdrukken op desktopprinters en proofers. De gemaakte PDF-documenten kunnen worden geopend met Acrobat en Adobe Reader 5.0 en hoger.)
    /NOR <>
    /POL <>
    /PTB <>
    /RUM <>
    /RUS <>
    /SKY <>
    /SLV <>
    /SUO <>
    /SVE <>
    /TUR <>
    /UKR <>
    /ENU (Use these settings to create Adobe PDF documents for quality printing on desktop printers and proofers.  Created PDF documents can be opened with Acrobat and Adobe Reader 5.0 and later.)
    /JPN <>
  >>
  /Namespace [
    (Adobe)
    (Common)
    (1.0)
  ]
  /OtherNamespaces [
    <<
      /AsReaderSpreads false
      /CropImagesToFrames true
      /ErrorControl /WarnAndContinue
      /FlattenerIgnoreSpreadOverrides false
      /IncludeGuidesGrids false
      /IncludeNonPrinting false
      /IncludeSlug false
      /Namespace [
        (Adobe)
        (InDesign)
        (4.0)
      ]
      /OmitPlacedBitmaps false
      /OmitPlacedEPS false
      /OmitPlacedPDF false
      /SimulateOverprint /Legacy
    >>
    <<
      /AddBleedMarks false
      /AddColorBars false
      /AddCropMarks false
      /AddPageInfo false
      /AddRegMarks false
      /ConvertColors /NoConversion
      /DestinationProfileName ()
      /DestinationProfileSelector /NA
      /Downsample16BitImages true
      /FlattenerPreset <<
        /PresetSelector /MediumResolution
      >>
      /FormElements false
      /GenerateStructure true
      /IncludeBookmarks false
      /IncludeHyperlinks false
      /IncludeInteractive false
      /IncludeLayers false
      /IncludeProfiles true
      /MultimediaHandling /UseObjectSettings
      /Namespace [
        (Adobe)
        (CreativeSuite)
        (2.0)
      ]
      /PDFXOutputIntentProfileSelector /NA
      /PreserveEditing true
      /UntaggedCMYKHandling /LeaveUntagged
      /UntaggedRGBHandling /LeaveUntagged
      /UseDocumentBleed false
    >>
  ]
>> setdistillerparams
<<
  /HWResolution [1200 1200]
  /PageSize [612.000 792.000]
>> setpagedevice


